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User Guide

1. User Guide for WorkZone 365 (former

WorkZone Office) 2021.1

Related product documentation

Developer Guide for WorkZone 365

WorkZone Client User Guide

Installation Guide for WorkZone

WorkZone links

l WorkZone documentation

l WorkZone support

l WorkZone website

l WorkZone portal
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2. What's new

2021.1

WorkZone Mail is now supported

l In Microsoft Outlook, users can save emails to WorkZone and edit email information in

the WorkZone 365 pane.

l Senders and recipients of the email are automatically added to it as parties with

Sender and Recipient roles. Users can also add other WorkZone contacts as parties.

l WorkZone 365 pane can be pinned in Outlook, so that it will not disappear when users

switch between emails.

l Users with the administrative rights can configure the WorkZone 365 pane in Outlook.

2021.0

WorkZone Office renamed to WorkZone 365

l We have changed the name of WorkZone Office to WorkZone 365. To be ready for the

future and Microsoft 365, we will handle all integrations to Microsoft under our new

name.

New functionality

l New Word, Excel, and PowerPoint documents can be saved to WorkZone.

l Users can change document state and manage parties for Word, Excel, and

PowerPoint.

l Users can merge case, document, and contact information into a Microsoft Word

template.
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l Users with the administrative rights can configure the WorkZone 365 pane in Microsoft

Word, Excel, and PowerPoint. See Configure Documents tab of the WorkZone 365

pane.

l From an opened Word, Excel, and PowerPoint document, users can open the

document and case on which it is saved in the WorkZone Client.

l For users with no write access to particular Word, Excel, and PowerPoint documents,

the WorkZone 365 pane will be disabled, and a warning "User does not have update

rights for this record in register: record" will be displayed.

Design improvements

l WorkZone 365 Add-ins are represented with a new icon.

2020.3

You can work with WorkZone 365, Microsoft Outlook meetings on macOS.

2020.2

New functionality

l The language of the WorkZone Add-ins for Microsoft Outlook, Word, Excel, and

PowerPoint now depends on the user settings in WorkZone.

2020.1

New functionality

l WorkZone for Office for Microsoft Word, Excel, and PowerPoint has been released. This

is the experimental version with limited functionality where you can only edit existing

documents. See Word, Excel, and PowerPoint.

5



WorkZone 365 2021.1

Important: This is not the version to be used in production. Please install and use

it only for testing purposes and sharing your feedback with us. We expect the MVP

production version in the 2021.0 release.

User experience improvements

l To easily assign yourself as a case handler or as another role, select @Me from the very

top of the WorkZone users list.

l To easily assign your organizational unit to a relevant field, select @MyUnit from the

very top of the unit list.

l To quickly set a date, you can specify a time period in relation to the current time. See

How to set a date.

Videos tutorials

l The video tutorial on how to work with WorkZone meetings and agenda items has

been added. The video on Meeting reports has been complemented with audio

narration and translated to Danish. See Video tutorials.

2020.0

New in WorkZone meetings

l Meeting organizers can cancel WorkZone meetings. See Cancel WorkZone meeting.

l Attendees can decline WorkZone meetings. See Decline WorkZone meeting.

l Only meeting organizer can now create the WorkZone meeting.

l If you save a meeting on a case and the meeting contains an email address that is

linked to multiple contacts, you must select one contact to be associated with the

email address for this particular case.
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l When you create a new meeting, it now contains a link to WorkZone Client in the

meeting body.

New in agenda items

l The search for documents via a case has been simplified. The filter now contains a

single field Case where you can start typing a case number, case title, or expand the

field to see the full list of cases.
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l You can open a document that is added to an agenda item in a relevant program. To

do this, click the document's name.

l When you generate a meeting report, you can turn on the Download toggle to save

the report on the local machine. Otherwise, it will only be saved on the WorkZone

meeting. Use this feature to view the report and share it with non-WorkZone users.

See Meeting reports.

Video tutorials

l If you prefer to take in information visually, please visit our new page Video tutorials.

It currently contains a video instruction on how to work with WorkZone meeting

reports. The page will be supplemented with new video tutorials on a continuous basis.

2019.3

New functionality:

l You can add attendees to the meetings.

l You can attach documents from the WorkZone server to agenda items.

l You can generate meeting reports.

User guide usability:

You can work in WorkZone Outlook by using a desktop application or on the web. Please be

aware that user interface of the desktop and web applications have minor differences. To see

only relevant information in the documentation, please select your application:
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By default, you see documentation for the desktop Outlook.

2019.2

This is the first version of the WorkZone 365 User Guide
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3. Work in Word, Excel, and PowerPoint

Notes:

The language settings and the Date field pattern in the WorkZone 365 pane depend on the

user settings in WorkZone.

For users with no write access to particular Word, Excel, and PowerPoint documents, the

WorkZone 365 pane will be disabled, and the warning "User does not have update rights for

this record in register: record" will be displayed.

3.1 Create and edit Word, Excel, and PowerPoint documents

To edit new or existing Word, Excel, and PowerPoint documents, proceed with the following

steps:

1. Open a Word, Excel, or PowerPoint document.

2. Go to the Home tab and clickWorkZone in the main ribbon. The WorkZone 365

pane then opens.
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3. If you want to work with a new Word, Excel, and PowerPoint document, you should

save it to WorkZone. Click Save on the WorkZone 365 pane to save the document

to WorkZone. After this, the fields in the pane will be disabled and the Action

required alert is shown. In the alert dialog, select Open document. A new

window opens where you can edit your document. You can close the window that

contains the original document.
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4. Change document content and/or WorkZone information such as title, document

type, and other fields.

5. Click Save on the WorkZone 365 pane to save WorkZone information.

6. Type Ctrl+S to save the changed content.

Note: You can skip this step for the Word and Excel documents—content is

saved once you click the Save button in step 5.

3.2 Document information

l Title – Enter title of the document.

l Document Type – The document type indicates whether the document is, for

example, incoming, outgoing, or internal.

l Classification – Classification orders and prioritizes data based on its sensitivity. By

default, the classification code is inherited from the selected case, but you can change

it in this field. Note that supplementary documents inherit classification codes from

their main documents.

Important:

l Classification on the unsaved document is updated every time you change

its main document or case.

l Classification on the saved documents is not automatically updated when

you change classification on the documents' case or main document.

l State – Document state shows what you can do with the document: who can see and

edit it, and what can be edited. The document state is reflected in the document's life

cycle.
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o Personal draft – UP. Can be viewed, edited and deleted by the creator only.

Tip: To allow other employees view, edit and delete your personal draft

document, you must change the state to Draft.

o Draft – UÅ. When you save a document as a draft, you and other people in

your department or organization can edit the document in its native program.

o Locked document – UL. The document itself cannot be edited by anyone,

but document information can be edited by any user. Once saved, you cannot

revert the document state to draft.

o Archived – ARK. The document itself cannot be edited by anyone, but

document information can be edited by anyone. Once saved, you cannot

revert the document state to draft.

l Case Handler – Responsible contact for the document. By default, this is the contact

who created the document. To assign another contact as case handler, remove the

contact's name and start typing the required contact's name.

l Document Group – Select the group to which the document belongs, for example,

Decision, Confirmation, Consultation.

l Main Document – If your document is a supplementary document, select a main

document.

Note: When your document is saved in the archive as a supplementary document,

theMain document drop-down list is locked. If you want a different main

document, you must select it in WorkZone Client.

l Letter Date – Click the calendar icon to change the letter date. The default value of

this field is today's date.

l Reply Deadline – Click the calendar icon to type the date by which the document

should be answered.
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Note: If you have specified a letter date and a reply date, you should also add a

sender and a recipient. See Manage document parties.

3.3 Manage document parties

Document parties are the contacts that relate to the document. The contact's role (for

example, Sender, Author) defines how the contact relates to the document.

14



User Guide

1. On the Parties tab of the WorkZone 365 pane, use the Add parties search field to

add parties to the document. The parties available in the search are specified for

this document in WorkZone Client. You can search by name or address.

When you make a search for parties, use a wild card operator * to replace one or

more characters. For example, type "Eliz*" to find "Elizabeth".

2. If necessary, specify roles for the parties. The default role is Recipient.

3. Click the "X" near the party to remove it.

4. Click Save.

3.4 Merge case, document, and contact information with a
Word template

You can merge case, document, or contact information with a Microsoft Word template.

Each template includes content controls. A Content control represents an information field of

a case, document, or contact (party); for example, (Case, Case handler) Name 1,

(Document) Title, and so on. When you merge a template with a certain case or document,

content controls extract the related values from the case or document. For example, (Case,

Case handler) Name 1 can obtain value Ann, (Document) Title can obtain value Application

form, and so on.

Note: Merge is not available for the archived or locked documents.
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Merge to a document not saved to WorkZone

1. Open a relevant template with the inserted content controls.

2. Go to the Home tab and clickWorkZone in the main ribbon. The WorkZone 365

pane opens. Fill in all mandatory fields on the Document tab to activate theMerge

button.

3. On the WorkZone 365 pane, select the icon>Merge.

After this, the document will be saved to WorkZone Content Server and the merge

will start.

4. A merged document with the values inserted from the WorkZone Content Server

and WorkZone 365 pane fields opens as a new Word document.

You should open the WorkZone 365 pane again if you want to edit its fields for the

merged document.

Merge to an existing WorkZone document

1. Open a relevant WorkZone document with the inserted content controls.

2. Go to the Home tab and clickWorkZone in the main ribbon. The WorkZone 365

pane opens. Fill in all mandatory fields on the Document tab to activate theMerge

button.
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3. On the WorkZone 365 pane, select icon>Merge.

4. A merged document with the values inserted from the WorkZone Content Server

and WorkZone 365 pane fields opens as a new Word document.

You should open the WorkZone 365 pane again if you want to edit the fields for the

merged document.

Note: The state of the original document from which merge has been launched will be

changed to Personal draft – UP. The new merged document will open in the state that

was specified in the original document before it was merged.

3.5 Open document or case in WorkZone Client

WorkZone Client provides a broader list of actions on changing the case and document details.

For example, you can define access codes or move a document to a different case. To open

cases and documents in WorkZone Client:

1. Go to the Home tab of Word, Excel, or PowerPoint and clickWorkZone in the main

ribbon. The document registration pane opens.

2. To open the document in WorkZone Client, select Go to...>Document in WZ

Client on the WorkZone 365 pane.

To open the case on which the document is saved, select Go to...>Case in WZ

Client.
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4. Work in Outlook Mail and Meeting

Note: The language settings and the Date field pattern in the WorkZone 365 pane depend

on the user settings in WorkZone.

4.1 WorkZone Meeting

Note: WorkZone Meeting doesn't fully support recurring meetings yet.

You can create WorkZone meetings from new or existing appointments and meetings in your

Outlook calendar. You can add agenda items to your WorkZone meetings and attach

documents from WorkZone.

You can view and edit some information for an already created meeting either from Outlook or

from WorkZone Client. For example, you can add, edit, or delete agenda items or documents

saved on them.

Note: Only the meeting organizer can create the WorkZone meeting.

Create a new WorkZone meeting

If you have created an Outlook meeting, you can create it as a WorkZone meeting. When you

create a WorkZone meeting, a new case is created. Note that you cannot save a meeting on

already existing case.

1. In Outlook, go to calendar.

2. Open a new or an existing Outlook appointment or meeting for which you want to

create a WorkZone meeting.
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3. Click theWorkZone button.

1. Edit the meeting details. See Manage attendees.

2. If needed, add one or more agenda items to the meeting. See Manage agenda

items.

3. Click Create Meeting if you want to create a WorkZone meeting for a new Outlook

meeting.

Tip: The body of a WorkZone meeting contains a link to this meeting in WorkZone Client.

Note: Save your changes to a new Outlook appointment before closing it.

Note: If you are using macOS, save your changes to a new Outlook appointment before

closing it.

Open a meeting in WorkZone Client

You can open a detail page for a meeting in WorkZone Client and view all information on this

meeting. In WorkZone Client, you can also add, edit, or remove agenda items and the

documents saved on the meeting.

Click View in WorkZone Client on the body of the WorkZone meeting. The detail page of the

meeting opens in WorkZone Client.

Tip: Read more about WorkZone meetings in the User guide for WorkZone Client.

Cancel a WorkZone meeting

If you are a WorkZone meeting organizer, you can cancel the meeting that you organized. In

WorkZone, the state of the meeting will be changed to Canceled.
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To cancel the WorkZone meeting, follow this procedure:

1. Open the meeting.

2. Open the WorkZone pane.

3. Click the arrow next to the Update Meeting button and click Cancel Meeting.

The WorkZone meeting is now canceled.

4. Optionally, cancel the Outlook meeting. Then meeting's attendees will see in their

calendars that the meeting was canceled .

On the bottom of the WorkZone for Office pane, you can now see the Create Meeting button.

Click the button to create a new WorkZone meeting based on the existing Outlook meeting (if

you haven't canceled it). A new WorkZone case is then created. The agenda of the new

WorkZone meeting is empty. The Outlook meeting's attendees and organizer are saved as

case parties.

Decline a WorkZone meeting

If you are a WorkZone meeting attendee and you don't plan to participate in it, you can decline

the meeting. Once you declined it, it doesn't affect the meeting itself, but you're removed from

it as an attendee, that is as a case party.

Note: When you have declined the WorkZone meeting, it will still exist in your calendar as

an Outlook meeting. To remove it from your calendar, decline the Outlook meeting too.

To decline the WorkZone meeting, follow this procedure:

1. Open the meeting.

2. Open the WorkZone for Office pane.

3. Click the arrow next to the Update Meeting button and click Decline Meeting.

4.2 Manage attendees

Attendees are meeting participants including meeting organizer.
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Add attendees to the meeting

1. In the meeting, start typing a name of the needed contact or a group of contacts in

the People field.

2. Once you see the right contact or group, click it to add as an attendee.

3. Repeat steps 1-2 for all contacts which you want to invite to the meeting.

Add attendees to the meeting

1. In the meeting, click To....

2. Double-click contacts or groups which you want to invite to the meeting.

3. Click OK.
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Remove attendees from the meeting

To remove the attendee, click next to it.

To remove the attendee, select it and click Del on your keyboard.

4.3 Manage agenda

When you create a meeting, or when you open an existing WorkZone meeting, you can add

agenda items with additional information to it. You can attach documents from the WorkZone

server only.

You can manage agenda items on the WorkZone 365 pane. To open the pane, click >

Calendar. On the meeting page, click WorkZone for Office on the main ribbon:

You can manage agenda items on the WorkZone 365 pane. To open the pane, click the

WorkZone 365 button on the main ribbon.

Add an agenda item

1. In the top part of a meeting, click Add item.

2. Enter the title of your agenda item and, if needed, provide a description.

3. If needed, attach one or more documents to your agenda item. See Work with

documents.
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4. Click Save.

5. Repeat steps 1-4 until you have added all needed agenda items.

Tip: To reorder agenda items, drag an agenda item to the needed position.

Edit an agenda item

You can edit agenda items existing on your WorkZone meeting at any time.

1. Open a meeting where you want to edit an agenda item.

2. Point to the agenda item you need, and click Edit.

3. Make your changes. See Work with documents.

4. Click Save.

Delete an agenda item

1. Open a meeting where you want to delete an agenda item.

2. Point to the agenda item that you want to delete.

3. Click Delete, and then click Yes in the confirmation message.

Work with documents

You can add or remove WorkZone documents from an agenda item.
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Add a document

Start typing the document's name in the Documents field. Select the needed documents.

Notes:

l
Click to search by case title or case number.

l You can use operators *, ^ in Documents search but not in Case search. See Search

operators.

l When documents are attached, you can reorder them by dragging.

View a document

When the document is saved on an agenda item, you can view it in the corresponding program.

To do this, click its icon that is located prior to the title.

Tips: Due to functional limitations of Internet Explorer, there are cases when the

document cannot be open in this browser. There are two workarounds:

l Ask your administrators to add WorkZone for Office add-in host to the trusted sites.

Then you will get the link to download the document.

l Switch to Edge or Chrome and proceed.
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Remove a document

Click next to the document that you want to remove.

Note: Mind absence of a confirmation message. Ensure that you are about to delete the

document before the action.

4.4 Meeting reports

Tip: You can also see the video tutorial Working with WorkZone meeting reports.

Create a meeting report

You can generate a report so you have all information about the meeting in a single PDF file.

The report contains general information about the meeting (time, participants, etc.), agenda

items, and attached documents.

Prerequisite: To generate a report, the WorkZone meeting must already exist.

1. Open a meeting for which you want to generate a report.

2. Click the Create Report button on the WorkZone 365 pane.

3. Enter title, document type, classification, and other information relating to the

report.

4. To download the report on the local machine, turn on the Download toggle.

5. Click Create Report. The report is generated and attached to the meeting. You can

see it in WorkZone Client on the relating meeting detail page on the Documents

detail tab. If you have turned on the Download toggle, the PDF file is saved both

locally and on the case.

Tips: Due to functional limitations of Internet Explorer, the report cannot be saved in this

browser. There are two workarounds:
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l Ask your administrators to add a WorkZone 365 add-in host to the trusted sites. Then

you will get the link to download the report.

l Switch to Edge or Chrome and proceed.

Share a meeting report

WorkZone users can always generate the meeting report themselves, or they can find the

generated report on the relevant case.

To share a meeting report with non-WorkZone users, proceed with the following steps:

1. Create a meeting report and save it locally.

2. Open the existing meeting or create a new email depending on what audience you

want to share the report with.

3. Go to the Insert tab.

4. Click Attach File > Browse This PC... and attach the report.

5. Click Send Update for the existing meeting or Send for the new email. Now all

recipients can see the report even if they are not WorkZone users.

1. Create a meeting report and save it locally.

2. Open the existing meeting or create a new email depending on what audience you

want to share the report with.

3. Click Attach and attach the report.

4. Click Send. Now all recipients can see the report even if they are not WorkZone

users.

Note: Only meeting organizers can attach meeting reports and other files to the meetings

they created.
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4.5 Edit emails in WorkZone

In Microsoft Outlook, you can edit email information in the WorkZone 365 pane for sent or

received emails. An email and its attachments are saved to WorkZone as a single .eml file.

Prerequisite: WorkZone 365 Outlook - Mail module is only supported with Microsoft

Exchange Server Online. It is not supported with Exchange Server 2019 or Exchange Server

2016.

Tips:

o All sent and received emails are saved to WorkZone. Send a new email to save it to

WorkZone.

o
Click Pin in the upper right corner of the WorkZone 365 pane, to pin the

pane, so that it would not close when you switch between emails. However, if you

need to switch quickly between several emails , we recommend not to pin the

WorkZone 365 pane, and open it for a particular email on which you want to work

in WorkZone (please see Outlook Mail — Incorrect data is shown for some time in

the pinned WorkZone 365 pane when you are quickly switching between emails).

For the emails that are saved in WorkZone, you can change information in all fields except

Case which is always set to Desktop case by default. Before an email is saved to WorkZone

for the first time, you can choose between selecting the Archived – ARK or the Locked

document – UL email state in the State field.

o Locked document – UL. The email state can be changed to Archived – ARK.

o Archived – ARK. The email state cannot be changed.

Click Save after changing the email information in the WorkZone 365 pane to save your

changes to WorkZone.

Note: You can also work with a saved WorkZone email in WorkZone Client and WorkZone

Explorer.
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Configure the WorkZone 365 pane

Please see Configure Documents tab of the WorkZone 365 pane.

Manage email parties

Email parties are the contacts that relate to the email. The contact's role (for example, Sender,

Recipient) defines how the contact relates to the email.

When you open the WorkZone 365 pane, the contacts of an opened email will automatically be

added as parties to the Parties tab:

o The email sender will be saved as a party with the Sender role.

o The email recipients in the To and Cc lines of the email will be saved as parties with

the Recipient role.

o The recipients in the Bcc line of an email will not be added as email parties.

Note: You will be notified if an email contact is not found in the WorkZone database, or if

there is more than one contact with the same email in WorkZone database.

You can add other WorkZone contacts as email parties.

1. On the Parties tab of the WorkZone 365 pane, use the Add parties search field to

add parties to the email. The parties available in the search are specified for the

email in WorkZone Client. You can search by name or email.

When you make a search for parties, use a wild card operator * to replace one or

more characters. For example, type "Eliz*" to find "Elizabeth".

2. If necessary, specify roles for the parties. The default role is Party.

3. Click the "X" near the party to remove it.

4. Click Save.
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5. Configure Documents tab of the WorkZone

365 pane

Important: Only users with the CONFIGADM access code can configure the Document tab

of the WorkZone 365 pane.

To open the Edit configuration form, in the lower-right corner of the WorkZone 365 pane,

click the icon>Configure .

Edit the configuration of the Documents tab and then save your changes.
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1. Edit configuration

Note: Don’t forget to save your changes after editing.

Change order of the fields

To change the order of the fields, drag a field up or down.
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Make fields visible or invisible

Note: Title, Document type, Classification, State, and Case fields cannot be made

invisible.

The fields can be visible (marked with the Visible icon ) or not visible (marked with the

Not visible icon ). Click the visibility icon to change the setting to the opposite.

Manage field properties

1. Select Field properties icon near the field.

2. Select or clear the Read-only or Required check boxes.

Note: Only one of these check boxes can be selected for the field. Clear one of the check

boxes before selecting another.

2. Save or discard configuration changes

When saving changes in the configuration for the first time, select Create in the bottom of the

Edit configuration form.

Next time you make changes in to the configuration, you will see Save instead of Create. Click

Save to save the changes.

Select Cancel to discard the changes.

3. Reset the configuration to default

1. Open the Edit configuration form.

2. Select Reset in the bottom of the Edit configuration form.

3. Select Save.
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Note: The Reset button is available only after some changes have been made to the

default configuration.

5.1 How to set a date

When you set or edit a date, you can use one of these options:

l Type the exact date.

l Select the date from the calendar.

l Specify a time period in relation to the current time, for example, + 2 weeks or - 4

hours.

To specify the time period, use the following syntax that is aligned with both Danish and

English:

Value Meaning

+ Add a date in the future

- Add a date in the past

Å

Y

Year

M Month

U

W

Week

D Day

Example:

+4u – You set a date of 4 weeks after the current day.

-1y – You set a date of 1 year before the current date.
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Notes:

l You can only enter a simple value for each date field, for example, +7w. Do not use

compound values, for example, +1m3w.

l Day is the default time period. If you just enter a number without a time value,

WorkZone for Office counts it as a day. Thus, +6 equals +6d.

5.2 Use search

When you make a search, you enter search criteria in a text field or in a free text fields. Search

operators can be typed with small letters, capital letters, or a mix.

Search operators

Operator Name Used where? Description

* Wild card Free text fields

and text fields

Replaces one or more characters.

Example

If you type:

l day* – the search finds documents where

a word in a text field or in a free text field

starts with day. For example, daylight.

l *day* – the search finds documents

where a word in a text field or in a free

text field contains day. For example,

nowadays.

l *day – the search finds documents where

a word in a text field or in a free text field

ends with day. For example, birthday.
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Operator Name Used where? Description

Note: Using prefixed wild cards is not

recommended in free text searches, for

example *day and *day*. This type of search

can generate numerous search results and take

very long time to perform.

? Question
mark

Free text fields Replaces exactly one character.

Example: If you type Pe?ersen in the Free text

field of the Add/Remove Parties dialog box, the

search finds all parties with the name Petersen or

Pedersen but not Pettersen.

^ Hat
(circumflex)

Text fields Disregards casing.

Example: Text field Title

If you type ^*sun*, the search finds documents

where a word in the Title field contains sun, for

example, Sunday and sunlight.

|

OR

OR Free text

fields:

|and OR

Text fields:

|

Searches for items where one or more of the

entered words occur.

A free text search for documents will search in

fields and in the document itself.

Example: Find all documents where at least one

of the words currency or exchange occur by typing

currency OR exchange.

&

AND

AND Free text

fields:

& and AND

Searches for items where all entered words occur.

Example: Find all documents where the words

currency and exchange occur by typing currency
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Operator Name Used where? Description

Text fields:

(except for

"Case title")

AND exchange (the words may exist as document

properties or as indexed free text).

Note: If you want to search for the character

&, not as an operator but, for example, as part

of a contact, insert a backslash in front of the

character, \&.

If you want to find Liebestraum, Immergut & Co,

type Liebestraum, Immergut \& Co.

~

NOT NOT

Free text fields

Text fields:

NOT

Searches for items where words you type after the

operator do not occur.

Example: Find all documents where interest but

not bank occur by typing interest NOT bank.

Note: You should always search for an item

containing this but not that. That is, searching

for only NOT bank will not return any results.

Multiple words or sentences

You can type one or more words in the search field:

l If you type one word, search results will contain this word.

l If you type multiple words, search results will contain exactly these words. For

example, a sentence without operators: Does surface activity of the sun influence our

climate.

l If you do not know the exact wording, it is recommended that you search for single

words combined with search operators.

Example:
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If you type in a combination of words that does not exist in the database, for example, Does

surface activit* of the sun influence our climate, there will be no search results. The chance

of finding what you are looking is greater if you type surface activity* AND sun*.
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6. Troubleshooting and tips

OAuth2 authentication mode — Cannot open the documents from an agenda item in

Microsoft Outlook

If your organization uses OAuth2 for user authentication, you must log in to WorkZone Explorer

to be able to open the non-Microsoft Office documents from an agenda item in Outlook.

Outlook Mail — Incorrect data is shown for some time in the pinned WorkZone 365

pane when you are quickly switching between emails

Please be aware that after you have been quickly switching between emails in the Outlook while

the WorkZone 365 pane was pinned, and then you stop on one of the emails, you may see the

data for another email in the WorkZone 365 pane for a while . If you need to switch between

many emails very quickly, we recommend not to pin the WorkZone 365 pane, and open it for a

particular email on which you want to work in WorkZone.

Outlook Mail — Cannot open saved emails in WorkZone Client

If you don’t have the installed WorkZone for Office Add-in, currently you cannot open the

emails saved to WorkZone via the WorkZone 365 Add-in in WorkZone Client. In this case

please use Microsoft Outlook or WorkZone Explorer to view the email saved to WorkZone.

Outlook Mail — WorkZone 365 Add-in button is disabled when the email is opened

as an .eml file in WorkZone Client or WorkZone Explorer

It is a known issue. Please use the WorkZone 365 pane in Microsoft Outlook to edit the

WorkZone email information.
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macOS — Cannot create or update WorkZone meeting in Outlook with multiple

accounts

It is a known issue. You cannot create or update WorkZone meeting in Outlook because

WorkZone only supports one mail account on macOS. The meeting is opened with the message

"Meeting is declined" or "You either don’t have rights to view the WorkZone meeting, or it

doesn’t exist yet. Note that only meeting organizer has rights to create the WorkZone

meeting." when the user adds multiple calendars to the Outlook.

macOS — The Create button is disabled for recurring meetings when trying to

create a WorkZone meeting

It is a known issue. The Create button is disabled in Outlook because you cannot create a

separate WorkZone meeting in the recurring meetings on macOS.

macOS — Cannot open the WorkZone 365 panel for Microsoft Word documents that

are archived or locked

It is a known issue. The WorkZone 365 icon is disabled in Microsoft Word for the documents in

the archived or locked state. The document registration tab is also disabled, and you cannot

edit the panel fields.

You have not made any changes to the document but when closing it you are asked

if you want to save your changes

It is a known issue. It is safe to select any option. This issue may happen after opening a

WorkZone 365 pane in a Word, Excel, or PowerPoint document.

Chrome — Cannot download a WorkZone meeting report in Outlook

It is a known issue. Currently you cannot download reports from Outlook using Chrome. Please

use another browser.
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When using Outlook in a browser, you cannot update a WorkZone meeting via the

WorkZone 365 pane

It is a known issue. Sometimes when you close the meeting window in the Outlook after

clicking Update meeting in the WorkZone 365 pane, you get a message prompting you to

confirm that you want to discard the meeting changes. Please close this message and click

Send in the Outlook meeting window. Your changes to the meeting will be saved.
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7. Terms and conditions

Intellectual property rights

This document is the property of KMD. The data contained herein, in whole or in part, may not

be duplicated, used or disclosed outside the recipient for any purpose other than to conduct

business and technical evaluation provided that this is approved by KMD according to the

agreement between KMD and the recipient. This restriction does not limit the recipient’s right

to use information contained in the data if it is obtained from another source without restriction

set out in the agreement between KMD and the recipient or by law.

Disclaimer

This document is intended for informational purposes only. Any information herein is believed

to be reliable. However, KMD assumes no responsibility for the accuracy of the information.

KMD reserves the right to change the document and the products described without notice.

KMD and the authors disclaim any and all liabilities.

Copyright © KMD A/S 2021. All rights reserved.
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